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Модуль 4. Схемы на операционных усилителях. 

Лабораторная работа № 4.1 

Типовые схемы включения операционных усилителей 

 

1. Цель работы 

Овладение методикой исследования параметров и характеристик 

типовых схем операционных усилителей. 

 

2. Задачи исследования 

 подготовка к лабораторной работе, т.е. формирование знаний и 

пониманий процессов, происходящих в исследуемой схеме; 

 проработка разделов порядка выполнения работы. Поиск ответов 

по каждому пункту на вопросы: как его реально выполнить? Что долж-

но быть получено в результате его выполнения (прогнозируемый ре-

зультат)?; 

 приобретение навыков исследования параметров и характери-

стик типовых схем операционных усилителей с использованием: 

 функционального генератора и осциллографа; 

 регулируемых источников питания; 

 цифрового мультиметра; 

 анализатора амплитудно-частотных и фазочастотных характери-

стик-АЧХ/ФЧХ). 

 обработка полученных экспериментальных данных, подготовка и 

защита отчета. 

 

3. Краткие сведения из теории 

Операционным называется усилитель, предназначенный для вы-

полнения математических операций при использовании его в схемах с 

обратной связью. Однако область применения операционных усилите-

лей (ОУ), выполненного в виде микросхемы, значительно шире. Поэто-

му в настоящее время под ОУ принято понимать микросхему – усили-

тель постоянного тока, позволяющий строить узлы аппаратуры, функ-

ции и технические характеристики которых зависят в основном от 

свойств цепи используемой обратной связи. 

Таким образом, операционные усилители предназначены для про-

ведения различных линейных и нелинейных операций над входными 
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сигналами. Применение глубоких обратных связей позволяет обеспечи-

вать высокое качество таких преобразований. 

Согласно классификации по ГОСТ 4.465 ОУ делятся на универ-

сальные (общего применения), прецизионные (инструментальные), ре-

гулируемые (микромощные) и т. д. 

С другой стороны в зависимости от соответствий входного и вы-

ходного сопротивлений ОУ с сопротивлениями источника сигнала и 

нагрузки различают усилители: с потенциальным или с токовым вхо-

дом, с токовым выходом. В зависимости от возможности получать ам-

плитуду выходного сигнала до уровня напряжения примененного ис-

точника питания различают усилители типа rail-to-rail и т. д. 

В справочной литературе обычно описывают следующие основные 

параметры ОУ: 

 коэффициент усиления по напряжению: отношение изменения 

выходного напряжения к вызвавшему его изменению входного диффе-

ренциального напряжения; 

 частота единичного усиления: значение частоты входного сигна-

ла, при котором значение коэффициента усиления напряжения падает 

до единицы; 

 максимальное выходное напряжение: максимальное значение 

выходного напряжения, при котором искажения не превышают задан-

ного значения; 

 скорость нарастания выходного напряжения: отношение его из-

менения от 10 до 90 % от своего номинального значения ко времени, за 

которое произошло это изменение; 

 напряжение смещения: значение напряжения, которое необхо-

димо подать на вход ОУ, чтобы выходное напряжение было равно ну-

лю; 

 входные токи: токи, протекающие через входные контакты ОУ; 

 разность входных токов; 

 дрейф напряжения смещения; 

 дрейф разности входных токов; 

 максимальное входное дифференциальное напряжение: напря-

жение, прикладываемое между входами ОУ, превышение которого ве-

дет к выходу параметров за установленные границы или к разрушению 

микросхемы; 

 максимальное синфазное входное напряжение: наибольшее зна-

чение напряжения, прикладываемого одновременно к обоим входам ОУ 

относительно нулевого потенциала, превышение которого нарушает ра-

ботоспособность микросхемы; 
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 коэффициент ослабления синфазного сигнала: отношение коэф-

фициента усиления напряжения, приложенного между входами ОУ, к 

коэффициенту усиления общего для обоих входов напряжения; 

 выходной ток: максимальное значение выходного тока ОУ, при 

котором гарантируется работоспособность микросхемы. 

В измерительных устройствах необходимо усиливать с малыми ис-

кажениями слабые электрические сигналы, сопровождаемые значитель-

ным уровнем синфазных, температурных и других помех.  

Прецизионный усилитель, используемый для этих целей, должен 

обладать не только очень большими значениями коэффициентов усиле-

ния и подавления синфазного сигнала, но и малым напряжением сме-

щения нуля и его дрейфом, малыми уровнями шумов, большим вход-

ным сопротивлением. 

В лабораторной работе использован операционный усилитель 

OP07 (российский аналог КР140УД17), который является прецизион-

ным усилителем прямого усиления и широко используется в схемах из-

мерительных устройств. Наиболее полная информация об операцион-

ном усилителе OP07 приводится в DATA SHEET, представляемыми 

фирмами-изготовителями. Первая страница об этом ОУ приведена в 

Приложении А. 

Операционный усилитель КР140УД17 имеет внутреннюю частот-

ную коррекции и может работать в диапазоне питающих напряжений от 

3 до 18 В каждой полярности при симметричном (двух полярном) пита-

нии, которое в основном и будет использовано в лабораторном цикле.  

Предварительно познакомимся с важнейшими правилами, которые 

в первом приближении определяют поведение идеального ОУ, охвачен-

ного петлей глубокой ООС и работающего в линейном режиме, когда 

его входы и выход не перегружены.  

Правило 1: Входы идеального ОУ с бесконечно большим диффе-

ренциальным коэффициентом усиления эквипотенциальны, так как его 

дифференциальное входное напряжение стремится к нулю. 

Правило 2: Входы идеального операционного усилителя ток не 

потребляют. Такая идеализация говорит о том, что операционный уси-

литель имеет бесконечно большие значения своих дифференциального 

и синфазного входных сопротивлений.  

Правило 3: По выходу ОУ близок к источнику ЭДС, т.е. он имеет 

малое выходное сопротивление.  

Таким образом, идеальный ОУ является источником ЭДС, управля-

емым ЭДС. В зависимости от вида ООС различают инвертирующее и 

неинвертирующее включения ОУ. 
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3.1. Инвертирующее включения ОУ 

В инвертирующем усилителе (рис. 3.55) входной сигнал и сигнал 

обратной связи противоположного знака суммируются с помощью ре-

зисторов R1 и R2. Как известно, такая обратная связь называется парал-

лельной по входу. Что касается обратной связи по выходу, то она явля-

ется по напряжению, так как напряжение обратной связи 

UОС = ОСUВЫХ.. При ОС = R1/(R1+R2) = const пропорционально UВЫХ.. 

UВЫХ.UВХ.

R2

R1 DA1

+U

-U

out

+Еп

-Еп

A

B

 

Рис. 3.55. Типовая схема инвертирующего усилителя 

Зная вид обратной связи, и применив правила 1 и 2, можно опреде-

лить основные параметры инвертирующего усилителя при идеальной 

его модели  коэффициент усиления, входное и выходное сопротивле-

ния: 

1. Потенциал точки А равен потенциалу точки В и также равен по-

тенциалу земли. Поэтому в литературе точку А называют «виртуальная 

земля», «квазиземля» или «виртуальный нуль». 

2. Тогда UR1 = UВХ., а UR2 = UВЫХ.. 

3. Согласно правилу 2 и первому закону Кирхгофа получим следу-

ющее равенстово: UВХ./R1 = –UВЫХ./R2. 

Отсюда коэффициент усиления инвертирующего усилителя  

ИН ВЫХ. ВХ./ 2 / 1К U U R R   . 

Еще проще можно найти входное сопротивление усилителя. Так 

как UА = 0, то RВХ.И = R1.  

Даже если ОУ имеет конечное, но малое значение выходного со-

противления, то при ОС по напряжению выходное сопротивление схе-

мы RВЫХ.ИН:  

ВЫХ.ИН ВЫХ. ОУ У ОС/(1 β )R R К   , 

где RВЫХ.ОУ  выходное сопротивление ОУ, КУ – дифференциальный ко-

эффициент усиления ОУ. 
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В реальных ОУ без ОС, начиная с некоторой частоты СР (рис. 

3.56), наблюдается спад модуля коэффициента усиления. Поэтому АЧХ 

реального ОУ соответствует АЧХ фильтра нижних частот (верхняя ха-

рактеристика). 

0

KУ

K, дБ

KОС1

βОС1

βОС2

ωСР ωТωСР2ωСР1

ω

KОС2

3 дБ

3 дБ

3 дБ

 

Рис. 3.56. Амплитудно-частотные характеристики инвертирующих 

усилителей с разной глубиной обратной связи. 

При введении обратной связи АЧХ усилителя с обратной связью 

зависит от глубины введенной связи. Действительно имеем: 

ИН У У ОС( ω) γ ( ω)/(1+ ( ω)β )К j К j К j  ; У У( ω) (0)/(1+ ωτ)К j К j , 

где τ = 1/ωСР – постоянная времени реального ОУ, инерционность кото-

рого представлена звеном первого порядка с частотой среза ωСР на 

уровне -3 дБ;  

KУ(0) – коэффициент усиления ОУ на постоянном токе.;  

γ и βОС – коэффициенты передачи по напряжению входного и вы-

ходного напряжений в точку A схемы (рис. 3.59) соответственно. 

После простых преобразований получим: 

ИН
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К


 

 
. 

Следовательно, для такого усилителя частота среза увеличивается 

пропорционально глубине обратной связи βОС, полоса пропускания 

расширяется, а коэффициент усиления KУ(0) уменьшается. 

Полученные выражения являются базовыми и для неинвертирую-

щего усилителя. 
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Изображенная на рис. 3.92 схема инвертирующего включения ОУ 

не является принципиальной. Скорее всего, это схема для переменных 

составляющих тока и напряжения, так как в ней не показаны цепи пита-

ния, коррекции и смещения усилителя. 

В лабораторной работе в основном будет использовано симмет-

ричное, двухполярное питание (+ЕП и -ЕП), которое может быть получе-

но или от источников напряжения +15 B и -15 В, или от регулируемых 

источников (VPS): SUPPLY+ и SUPPLY-. 

Первый вариант (рис. 3.57) будет использован при исследовании 

амплитудной характеристики схем с ОУ. 

 

DMM

or

ScopeUВХ.

R2

R1 DA1

+U

-U

out

+Еп

-Еп

Supply+

or

Supply-

UВЫХ.= -UBX.(R2/R1)

 

Рис. 3.57. Инвертирующее включение ОУ с двух полярными источниками 9В 

Как известно, амплитудной характеристикой (АХ) является зави-

симость выходного напряжения схемы от входного. Для инвертирую-

щего усилителя идеализированная АХ будет соответствовать рис. 3.58, а 

наклон АХ на линейном участке определяется коэффициентом усиления 

по напряжению, т.е. зависит от номиналов используемых резисторов в 

цепи обратной связи. 

UВЫХ.

UВХ.

Линейный режим

(0,8 – 0,9)·U

-(0,8 – 0,9)·U

 

Рис. 3.58. Типичный вид амплитудной характеристики инвертирующего 

включения ОУ для двух полярного и симметричного питания 

При использовании двух полярных напряжений питания ограниче-

ние значений максимального выходного напряжения в схемах с подоб-
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ными операционными усилителями происходит на уровне (0,8÷0,9) от 

значений источников питания. 

Если модули напряжений питания одинаковы, то изломы на АХ 

будут симметричными. Для разных значений модулей уход с линейного 

режима работы схемы в нелинейный режим будет ассиметричным. 

Второй вариант (рис. 3.59) двух полярного питания может быть 

применен для исследования схем на максимальную амплитуду выход-

ного гармонического сигнала, когда на входе действует напряжение с 

выхода Fgen генератора FGEN. 
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Рис. 3.59. Инвертирующее включение ОУ с двух полярными источниками 

питания от NI ELVIS: SUPPLY+ и SUPPLY- 

Если ОУ работает в линейном режиме, то выходной сигнал также 

будет практически гармоническим (рис. 3.60).  

UВЫХ.

UВХ.

t

t

Линейный режим  

Рис. 3.60. Работа ОУ в линейном режиме. 

Когда на некоторых участках входное напряжение переводит ОУ в 

нелинейный режим работы, то на выходном напряжении формируется 

отсечка: симметричная при симметричной амплитудной характеристике 

(рис. 3.61) и не симметричная в противном случае. 

Использование двухполярного источника питания не является 

единственно возможным. Схема с однополярным питанием, например, 
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реализуется тогда, когда один из входов ОУ, куда подключается источ-

ники питания, заземляется. 

UВЫХ.

UВХ.

t

Линейный режим

t

 

Рис. 3.61. Формирование отсечки выходного напряжения при заходе 

усилителя в нелинейный режим работы 

Представим, что в схемах, изображенных на рис. 3.57 или 3.59, 

оставлен только источник питания положительной полярности. Здесь 

входное напряжение привязано не к средней точке источников питания 

как это обычно делается в случае двух полярного питания ОУ, а к отри-

цательному полюсу источника питания. 

Эта схема не работает, если входное напряжение положительно, 

поскольку выходное напряжение должно в этом случае становиться от-

рицательным, а отрицательного источника питания здесь нет. 

Наиболее естественно использовать однополярное питание ОУ то-

гда, когда источник входного сигнала имеет постоянную составляю-

щую, желательно на уровне половины примененного в схеме питания. 

На рис. 3.62 и 3.63 представлены примеры схем подключения ис-

точника смещения при однополярном питании ОУ.  

Scope

R2

R1 DA1

+U

-U

outFgen

GND

Supply+

UВХ. UВЫХ.

+Еп

 

Рис. 3.62. Дифференциальный усилитель 
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Рис. 3.63. Неинвертирующий сумматор 

Схема на рис. 3.62 представляет собой дифференциальный усили-

тель, а на рис. 3.63  неинвертирующий сумматор. 

Приведенные на рис. 3.62 и 3.63 схемы при грамотном их исполь-

зовании позволяют передавать знакопеременные входные напряжения 

на выход при линейном режиме работы ОУ, т.е. практически без иска-

жений. Однако, как нетрудно заметить, в выходном напряжении может 

присутствовать постоянная составляющая, что не всегда желательно для 

пользователя. 

 

3.2. Неинвертирующий усилитель 

Неинвертирующий усилитель является второй базовой схемой уси-

лителя на основе ОУ. Основное применение такого усилителя – постро-

ение усилителя со сравнительно большим входным сопротивлением и 

без инверсии входного напряжения.  

Такие свойства неинвертирующего усилителя во многом обуслов-

лены использованием последовательной ООС по напряжению. В отли-

чие от инвертирующего включения рассматриваемый усилитель в типо-

вом включении содержит три резистора (рис. 3.64), из которых R3 необ-

ходим для обеспечения режима работы входного каскада ОУ по посто-

янному току. Наличие R3 приводит к ограничению максимального 

входного сопротивления неинвертирующего усилителя: RВХ.НИН = R3. 

Значение сопротивления R3 варьируется в пределах десятки кОм – де-

сятки МОм в зависимости от того, какие транзисторы – биполярные или 

полевые – используются во входных каскадах ОУ. Заметим, что при ра-

боте неинвертирующего усилителя в режиме усилителя постоянного то-
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ка от источника входного сигнала с гальванической связью нет необхо-

димости в установке сопротивления R3. Тогда входное сопротивление 

неинвертирующего усилителя определяется в основном синфазным 

входным сопротивлением ZСФ ОУ и может достигать величины порядка 

1012 Ом и выше. Однако с увеличением частоты из-за частотной зависи-

мости входной импеданс Zсф неинвертирующего усилителя уменьшает-

ся.  

R2
R3

DA1

+U

-U

out

GND

UВЫХ.

+Еп

R1

-Еп

UВХ.

A

 

Рис. 3.64. Типовая схема неинвертирующего усилителя 

Для получения выражения коэффициента усиления воспользуемся 

ранее изученными правилами. Согласно первому правилу UВХ. = UА. Из 

второго правила следует: 

A ВЫХ.

1

1 2

R
U U

R R
 


. 

Тогда коэффициент усиления неинвертирующего усилителя: 

НИН ВЫХ. ВХ.

2
/ 1

1

R
К U U

R
   . 

Как видно из выражения, на основе неинвертирующего включения 

ОУ нельзя выполнить операционный делитель. К тому же, в отличие от 

инвертирующего усилителя, в рассматриваемой схеме операционный 

усилитель работает с большой синфазной составляющей, равной вход-

ному сигналу. Это сужает функциональные возможности неинвертиру-

ющего ОУ. 

Выходное сопротивление неинвертирующего усилителя определя-

ется аналогично как и для инвертирующего включения, так как в обоих 

случаях ООС по выходу – по напряжению. 

На основе неинвертирующего усилителя можно выполнить повто-

ритель напряжения. На рис. 3.65 представлен наиболее часто применяе-

мый вариант усилителя с единичным коэффициентом усиления. В лите-
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ратуре он встречается под названием буферного усилителя, так как об-

ладает изолирующими свойствами – большим входным импедансом и 

малым выходным. 

R3

DA1

+U

-U

out

GND

UВЫХ.

+Еп

-Еп

UВХ.

 

Рис. 3.65. Повторитель напряжения на ОУ 
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4. Выполнение экспериментальных исследований в Multisim 10 

4.1. Основы работы в Multisim 10 

Для лучшего понимания технологии эксперимента (зачем, что и как 

делать?) и ясного представления ожидаемых результатов (что должно 

получиться?) рекомендуется во время внеаудиторной подготовки про-

делывать программу лабораторной работы в среде схемотехнического 

моделирования и анализа электрических схем Multisim. 

Multisim позволяет моделировать аналоговые, цифровые и цифро-

аналоговые схемы разной степени сложности. Имеющиеся в программе 

библиотеки включают в себя набор наиболее широко распространенных 

электронных компонентов. 

Интерфейс программы Multisim, приведенный на рис. 4.1, состоит 

из нескольких основных элементов, которые описаны ниже. 

 

Панель Вид

Стандартная панель

Строка меню

Панель Компонентов

Панель графического оформления

Запуск моделирования

Панель отладки

Основная панель

Панель Инструментов

Рабочее поле

Закладка активной схемы

Окно 

разработки

Горизонтальная прокрутка

Вертикальная прокрутка

Моделируемая схема

Рис. 4.1. Интерфейс программы Multisim 
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4.1.1 Окно разработки (Design Toolbox) 

В окне разработки (рис. 4.1) находятся средства управления раз-

личными элементами схемы. Закладка Иерархия (Hierarchy) отображает 

взаимосвязь между файлами открытого проекта в виде древовидной 

структуры. Закладка Доступность (Visibility) позволяет скрыть или 

отобразить слои схемы рабочей области. Закладка Проект (Project View) 

содержит информацию об открытом проекте. Пользователь может доба-

вить файлы в папки открытого проекта, изменить доступ к файлам и со-

здать архив проекта. 

4.1.2 Глобальные настройки 

Глобальные настройки позволяют настроить свойства среды 

Multisim. Доступ к ним открывается из диалогового окна «Свойства» 

(Preferences). Выберите пункт Опции/глобальные настройки 

(Options/Global Preferences), откроется окно «Свойства» (Preferences) 

(рис. 4.2) со следующими 

закладками:  

– Paths (Путь) – 

позволяет вам указать путь 

к файлам баз данных и 

другие настройки; 

– Save (Сохранить) – 

в этой закладке вы можете 

настроить период автома-

тического сохранения; 

– Parts (Компоненты) 

– позволяет вам выбрать 

режим размещения компо-

нентов и стандарт симво-

лов (ANSI или DIN). Так-

же здесь находятся 

настройки симуляции по 

умолчанию; 

– General (Общие) – 

здесь вы можете настро-

ить: режимы выделения 

объектов, колесо мыши и 

инструменты соединения 

проводников. 

 

Рис. 4.2. Глобальные настройки 
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4.1.3 Настройка листа 

Диалоговое окно настройки свойств листа (Sheet Properties) исполь-

зуется для изменения свойств каждого листа. Эти свойства сохраняются 

с файлом схемы, поэтому если проект открывается на другом компью-

тере, настройки не изменяются. Для того чтобы открыть свойства листа 

выберите пункт Опции/Свойства листа (Options/Sheet Properties), откро-

ется окно – рис. 4.3. 

Настройки листа сгруп-

пированы в следующие за-

кладки: 

– Circuit (Схема) – вы 

можете выбрать цветовую 

схему и внешний вид текста 

рабочей области. 

– Workspace (Рабочая об-

ласть) – вы можете настроить 

размер листа и его свойства. 

– Wiring (соединение) – 

настройки соединений про-

водников и шин. 

– Font (Шрифт) – вы мо-

жете выбрать шрифт, его раз-

мер и начертание для тексто-

вых элементов схемы. 

– PCB (Печатная плата) – 

настройки печатной платы. 

– Visibility (Доступность) – вы можете скрыть или отобразить до-

полнительные слои комментариев. 

Подробное описание каждого свойства листа, а также любых дру-

гих настроек можно посмотреть в руководстве пользователя Multisim 

(Multisim User Guide) или в файле справки Multisim (Multisim helpfile). 

4.1.4 Обзор компонентов 

Компоненты – это основной элемент принципиальной схемы. В 

среде Multisim присутствуют два типа компонентов: реальные (real) и 

идеальные (Virtual), рис. 4.4. 

 

Реальные компоненты Идеальные компоненты 

 

Рис. 4.3. Свойства листа 
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U2

OP07AH

3

2

4

7

6

81

 

    

VT1

BD139 

U1

DCD_HEX_BLUE

 

DA1

OPAMP_5T_VIRTUAL

 

 
DD1A

74S08D  

 
V1
2.5 V 

 

Рис. 4.4. Символы различных компонентов 

Реальные компоненты имеют четко определенные неизменяемые 

значения своих параметров, идеальные компоненты настраиваются 

пользователем в зависимости от решаемой задачи. 

В среде Multisim все компоненты разбиты на группы (groups) и се-

мейства (families) в соответствии с таблицей 4.1. 

Таблица 4.1  

Группы компонентов 

Groups Группы 

Source Components  Источники сигналов 

Basic Components Базовые компоненты 

Diodes Диоды 

Transistors  Транзисторы 

Analog Components  Аналоговые компоненты 

TTL  ТТЛ логика 

CMOS  КМОП логика 

Advanced Peripherals  Периферийные компоненты 

Misc. Digital Components Цифровые с мультивыбором компоненты 

Mixed Components  Смешанные компоненты 

Indicators  Индикаторы 

Power  Силовые компоненты 

Misc. Components  Дополнительные компоненты 

RF Components Радиочастотные компоненты 

Electromechanical Components  Электромеханические компоненты 

Для выбора группы компонентов и размещения компонента на ра-

бочем поле требуется кликнуть по соответствующей пиктограмме на 

панели компонентов (Components Toolbar), рис. 4.5. Откроется провод-

ник компонентов (Component Browser), рис. 4.6. Горячая клавиша по 

умолчанию для размещения компонента – Ctrl-W. 
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Рис. 4.5. Панель компоненты (Components) 

 

Рис. 4.6. Проводник компонентов (Component Browser) 

В Проводнике компонентов (рис. 4.6) отображается текущая база 

данных (Database), в которой хранятся отображаемые компоненты, опи-

сание выбранного компонента (Function), его модель и производитель. 

Для поиска компонента на вкладке «группа» (Group) выберете 

Select all groups (выбрать все группы) и в поле «компонент» 

(Component) начните набирать название компонента и проводник авто-

матически подберет подходящие элементы. Кнопка Поиск (Search) от-

крывает расширенный поиск. 

Символ звездочки «*» заменяет любой набор символов. Например, 

среди результатов запроса «LM*AD» будут как «LM101AD» так и 

«LM108AD». 

В среде Multisim присутствуют интерактивные компоненты, кото-

рые могут реагировать на действия пользователя. Изменение парамет-

ров этих компонентов сразу отражается на результатах эмулирования. 
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Компоненты управляются с помощью клавиш, указанных под каждым 

элементом. 

На рис. 4.7 приведено несколько компонентов: клавиша “А” увели-

чивает сопротивление потенциометра до 100% от указанной величины 

(1 кОм); клавиша “B” изменяет емкость переменного конденсатора; 

клавиша “С” регулирует индуктивность переменной катушки индуктив-

ности; пробел (space) – открывает или закрывает ключ. Например, что-

бы уменьшить сопротивление, зажмите Shift и нажмите “А”. 

R1

1kΩ

Key=A
30%

 

C1

100pF

Key=B

50%

 

L1

10µH

Key=C

50%

 

J1

Key = Space  

Рис. 4.7. Интерактивные компоненты 

Для просмотра или изменения свойств компонента необходимо два 

раза кликнуть по нему левой кнопкой мыши, после этого откроется окно 

свойств – рис. 4.8, а.  

 
 

а) б) 

Рис. 4.8. Свойства реального (а) и интерактивного (б) компонентов  

Для изменения "горячей клавиши" интерактивного компонента 

следуют в окне свойств (рис. 4.8, б) выбрать нужную клавишу из выпа-

дающего меню «клавиша» (Key). Поле «инкремент» (Increment) позво-

ляет в процентном отношении настроить приращение номинала компо-

нента.  
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4.1.5 Сдвиг, поворот и выделение компонентов 

После выбора компонентов из базы данных они размещаются на 

рабочем поле и соединяются между собой. Двойной щелчок по наиме-

нованию компонента или нажатие клавиши «Ok» в проводнике компо-

нентов позволяет выбрать компонент, а затем, просто кликнув в желае-

мом месте рабочего поля можно поместить компонент на него. 

Во время размещения ком-

понентов их можно вращать, 

нажимая "Ctrl+R". Чтобы по-

вернуть установленный компо-

нент, выделите его и нажмите 

"Ctrl+R" или кликнете на нем 

правой кнопкой мыши, откроет-

ся контекстное меню – рис. 4.9. 

В контекстном меню выберете 

повернуть на 90° по часовой 

стрелке (90 Clockwise) или про-

тив (90 CounterCW). 

Для выделения компонен-

та, просто кликнете по нему 

мышью, тогда он обозначится 

пунктирной линией. Клавиша 

Shift позволяет добавлять или 

снимать выделение с несколь-

ких компонентов. 

Для того чтобы отразить 

компонент кликнете на компо-

ненте правой кнопкой мыши и в 

контекстном меню выберите 

«отразить по горизонтали» (Flip 

Horizontal) или «отразить по 

вертикали» (Flip Vertical). 

Компоненты можно заме-

нять на другие с помощью кон-

текстного меню, для чего клик-

нете на компоненте правой кнопкой мыши, и в открывшемся кон-

текстном меню (рис. 4.9), выберете пункт «заменить компоненты» 

(Replace Components…). Новый компонент выбирается в открывшемся 

окне проводника компонентов.  

 

Рис. 4.9. Контекстное меню компонента 
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4.1.6 Соединение компонентов 

Для соединения компонентов кликните по выводу одного из ком-

понентов, чтобы начать вести соединяющий проводник, а для заверше-

ния соединения их между собой – кликните по конечному выводу. Ре-

зультат соединения двух компонентов (источника постоянного напря-

жения и резистора) представлен на рис. 4.10. 

V6
2.5 V 

R1

1kΩ

 

Рис. 4.10. Соединение компонентов 

Для размещения на рабочем поле проводника или узла кликнете на 

пустом месте рабочего поля правой кнопкой мыши, откроется кон-

текстное меню, выберите пункт «Добавить схемный объект» (Place 

Schematic на рис. 4.11), для добавления узла выберете Junction, а для 

проводника – Wire. 

 

Рис. 4.11. Контекстное меню «Добавить схемный объект» (Place Schematic) 

Для изменения цвета проводника кликнете на нем правой кнопкой 

мыши, откроется контекстное меню (рис. 4.12, а), выберете «Изменить 

цвет» (Change Color), в окне «Цвета» (Colors) (рис. 4.12, б) выберете 

требующийся цвет и нажмите «Ok». 
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а) б) 

Рис. 4.12. Редактирование цвета проводников  

 

Упражнение 1 – Поиск, размещение и соединение компонентов 

1. Создайте новый файл: Файл→Новый→Ввод схемы 

(File→New→Schematic Capture). 

2. Вызовите проводник компонентов с помощью кнопки Источники 

(Sources) на панели компонентов (Components Toolbar), рис. 4.13 или 

нажмите "Ctrl+W". 

 

 
Рис. 4.13. Панель компонентов (Components Toolbar) 

3. Найдите и поместите на рабочее поле компонент заземление 

(Ground), он находится в семействе источников питания 

POWER_SOURCES. 

4. Найдите и поместите на рабочее поле микросхему операционно-

го усилителя OP297AZ. Для поиска микросхемы на вкладке «группа» 

(Group) выберете Select all groups (выбрать все группы) и в поле «ком-

понент» (Component) начните набирать название OP297AZ и проводник 

автоматически подберет подходящий элемент. Перед тем, как поме-

стить компонент на рабочее поле, вам предложат на выбор один из двух 

операционных усилителей. Это обусловлено тем, что в одном корпусе 

микросхемы находятся два операционных усилителя. 

5. Выберите вариант А, поместите компонент на рабочее поле, за-

тем нажмите отмена (Cancel) – . 

6. Разместите на рабочем поле: два источника постоянного напря-

жения DC_POWER; один источник переменного напряжения 
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АC_POWER; два резистора номиналами 10 кОм и 50 кОм соответствен-

но; один компонент "Заземление" (Ground), рис. 4.14 

U1A

OP297AZ

3

2

4

8

1

V1
12 V 

V2
12 V 

R1

10kΩ

R2

50kΩ

V3

120 Vrms 

60 Hz 

0° 

 
Рис. 4.14. Элементы для сборки схемы 

7. Используя команды вращения, соедините компоненты в схему 

как показано ниже, рис. 4.15.  

U1A

OP297AZ

3

2

4

8

1

V1
12 V 

V2
12 V 

R1

10kΩ

R2

50kΩ

V3

120 Vrms 

60 Hz 

0° 

 
Рис. 4.15. Схема эксперимента 

8. Выполните настройку свойств компонентов. Два раза кликните 

по источнику переменного напряжения АC_POWER левой кнопкой 

мыши – откроется окно свойств, – установите действующие значение 

напряжения равным 1 В (Voltage (RMS)) и частоту сигнала равную 

1 кГц (Frequency (F)). Аналогично установите напряжение равным 15 В 

для источников постоянного напряжения DC_POWER. Схема примет 

вид показанный на рис. 4.15.  

9. Сохраните схему под именем Circuit1 командой 

Файл→Сохранить как (File→Save As).  

10. Конец упражнения 
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4.1.7 Графические аннотации 

В среде Multisim есть средства для графического оформления схе-

мы. На панели графических аннотаций (Graphic Annotation, рис. 4.16) 

присутствуют следующие элементы: картинки, многоугольники, дуги, 

эллипсы, прямоугольники, полилинии, линии, текст и комментарии.  

 

 

Рис. 4.16.  Панель графических аннотаций 

Чтобы добавить графический элемент, не используя панель графи-

ческих аннотаций, кликнете на пустом месте рабочего поля правой 

кнопкой мыши, откроется контекстное меню, рис. 4.17. В контекстном 

меню выберите пункт «Добавить графический объект» (Place Graphic). 

 

Рис. 4.17. Контекстное меню «Добавить графический объект» (Place 

Graphic) 

4.1.8 Использование интерактивного симулятора схем 

Перед началом симуляции внимательно все проверьте. У всех схем 

должен быть источник и заземление. Когда все готово, нажмите кнопку 

запуска симулятора  или F5. Запустится интерактивная симуляция. 



23 

 

Настройки интерактивной симуляции можно изменять в меню Си-

муляция→Настройки интерактивной симуляции (Simulate→Interactive 

Simulation Settings). Некоторые из настроек приведены на рис. 4.18. По 

умолчанию установлено время окончания симуляции через 1е+30 се-

кунд. Шаг по времени, и начальные условия определяются автоматиче-

ски. 

 

Рис. 4.18. Настройки интерактивной симуляции 

Чтобы посмотреть результаты симулирования схемы, воспользуй-

тесь динамическим пробником (Measurement Probe). Нажмите иконку 

пробника на панели инструментов (рис. 2.19), и курсор мыши будет вы-

полнять его роль, а при наведении на любой проводник в схеме отобра-

зятся следующие данные: 

 напряжение (мгновенное значение, амплитудное, среднеквадра-

тичное и постоянная составляющая); 

 частота. 

Результаты симуляции также отображаются на виртуальных при-

борах.  
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4.1.9 Виртуальные приборы 

Виртуальные приборы – это модели реальных приборов, таких как 

осциллографы, генераторы сигналов, анализаторы спектра и плоттеры 

Боде для отображения результатов эмуляции. 

Чтобы добавить виртуальный прибор, кликните по нему левой 

кнопкой мыши на панели инструментов (Instruments), рис. 4.19. 
 

 

Рис. 4.19. Панель инструментов (Instruments) 

Чтобы посмотреть лицевую панель прибора, дважды кликните на 

иконку прибора левой кнопкой мыши. Выводы прибора соединяются с 

элементами схемы аналогично соединению компонентов. 

В Multisim также есть эмулированные реально существующие при-

боры. К таким приборам, например, относится Tektronix TDS 2024 

Oscilloscope. Они выглядят и действуют точно в соответствии с техни-

ческим описанием производителя. 

В каждой схеме может быть использовано необходимое количество 

измерительных приборов, включая копии одного прибора. Каждая ко-

пия прибора настраивается и соединяется отдельно. 

Рассмотрим основные виртуальные приборы более подробно. 

4.1.9.1 Мультиметр (Multimeter) 

Мультиметр (Multimeter) предназначен для измерения переменного 

или постоянного напряжения или тока, сопротивления или затухания 

между двумя узлами схемы. Иконка и лицевая панель мультиметра при-

ведены на рис. 4.20.  

XMM1

 

 

Рис. 4.20. Иконка и лицевая панель мультиметра (Multimeter) 

Диапазон измерений мультиметра устанавливается автоматически. 

Внутреннее сопротивление и ток близки к идеальным значениям, но их 
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можно изменить, кликнув левой кнопкой мыши по кнопке "Set…" на 

лицевой панели мультиметра, а в открывшемся окне настроек 

(Multimeter Settings) установить необходимые параметры, рис. 4.21. На 

рис. 4.22, а показано подключение мультиметра для измерения тока, на 

рис. 4.22, б подключение для измерения напряжения, сопротивления и 

коэффициента затухания. 

 

Рис. 4.21. Окно настроек мультиметра (Multimeter Settings) 

 
а) 

 
б) 

Рис. 4.22. Подключения мультиметра для измерения тока (а) и напряжения, 

сопротивления, коэффициента затухания (б) 
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4.1.9.2 Функциональный генератор (Function Generator) 

Функциональный генератор (Function Generator) – источник пере-

менного напряжения синусоидальной, прямоугольной и пилообразной 

формы, иконка и лицевая панель представлены на рис. 4.23. 

XFG1

 

 

Рис. 4.23. Иконка и лицевая панель функционального генератора (Function 

Generator) 

Настройки генератора позволяют устанавливать частоту, амплиту-

ду, скважность и смещение сигнала. Для сигнала прямоугольной формы 

можно регулировать время нарастания и спада соответственно передне-

го и заднего фронтов, для этого кликните левой кнопкой мыши по 

кнопке "Set Rise/Fall Time" на лицевой панели генератора. 

 
2.2.9.3 Ваттметр (Wattmeter) 

Ваттметр (Wattmeter) предназначен для определения активной 

мощности. Иконка и лицевая панель ваттметра приведены на рис. 4.24, а 

схема подключения ваттметра показана на рис. 4.25. 

XWM1

V I

 
 

Рис. 4.24. Иконка и лицевая панель ваттметра  
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Рис. 4.25. Схема подключения ваттметра  

4.1.9.4 Осциллографы (Oscilloscope) 

В Multisim существуют двух и четырех канальные осциллографы 

(рис. 4.26 и 4.27), управление которых осуществляется так же, как и ре-

альными приборами. Они позволяют устанавливать параметры разверт-

ки по напряжению и времени, выбирать открытый или закрытый вход, 

тип и уровень срабатывания запуска и т. д. 

 

XSC1

A B

Ext Trig
+

+

_

_ + _

 

 

Рис. 4.26. Иконка и лицевая панель двухканального осциллографа  
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Рис. 4.27. Иконка и лицевая панель четырехканального осциллографа  

4.1.9.5 Плоттер Боде (Bode Plotter) 

Плоттер Боде (Bode Plotter) позволяет строить амплитудно-

частотную и фазо-частотную характеристики, рис. 4.28. Выводы "IN+" и 

"IN-" виртуального прибора подключаются параллельно входным за-

жимам исследуемого четырехполюсника, а выводы "OUT+" и "OUT-" – 

параллельно его выходным зажимам. 

XBP1

IN OUT

 

 

Рис. 4.28. Иконка и лицевая панель Плоттер Боде (Bode Plotter) 

 

4.1.9.6 Частотомер (Frequency Counter) 

Частотомер (Frequency Counter) – предназначен для измерения ча-

стоты сигнала, периода следования и длительности импульсов, времени 

нарастания и спада переднего и заднего фронтов, рис. 4.29. 
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XFC1

123

 

 

Рис. 4.29. Иконка и лицевая панель частотомера (Frequency Counter) 

 

4.1.9.7 Анализатор вольтамперных характеристик (IV Analyzer) 

Анализатор вольтамперных характеристик (IV Analyzer) предна-

значен для определения и визуализации вольтамперной характеристики 

(ВАХ) двухполюсников и трехполюсников (диодов, стабилитронов, 

транзисторов и т. д.), рис. 4.30. 

 

XIV1

 

 

Рис. 4.30. Иконка и лицевая панель анализатора вольтамперных 

характеристик (IV Analyzer) 

4.1.10 Анализ схем 

В cоставе Multisim имеются средства для анализа данных симуля-

ции. Чтобы начать анализ, зайдите в меню Симуляция→Анализ 
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(Simulate→Analyses) и выберите нужную функцию. Список всех функ-

ций Multisim приведен на рис. 4.31.  

 

Рис. 4.31. Функции анализа 

Для отображения результатов моделирования и анализа в графиче-

ском виде в Multisim используются две подпрограммы: постобработка 

(Postprocessor) и плоттер (Grapher).  

Плоттер (Grapher) – это основной инструмент просмотра результа-

тов симуляции. Он открывается из меню Вид→Плоттер 

(View→Grapher). Различные элементы плоттера представлены на рис. 

4.32. 

Данные отображаются на графике (Graph) и в таблице (Chart). Окно 

разделено на несколько закладок, число которых зависит от работаю-

щих функций анализа и используемых виртуальных приборов. Актив-

ный график обозначается красной стрелкой слева от него (рис. 4.32). 
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Перед началом редактирования свойств графика удостоверьтесь в том, 

что он активен. 

 

Строка меню Стандартная панель 

и панель свойств

Активный график

Закладки

Рис. 4.32. Плоттер (Grapher) 

Большинство настроек плоттера находятся на панели свойств, рис. 

4.33. 

 
Отобразить/

скрыть линии сетки

Отобразить/

скрыть легенду

Отобразить/скрыть 

курсорные измерения

Настройки 

масштабирования

Обратить цвета

Настройки 

плоттера

Настройки 

графика

Копировать 

настройки графика

Вставить

 настройки графика

Экспорт данных

Математические 

операции с графиками

Рис. 4.33. Панель свойств плоттера 

Можно изменять масштабы, диапазоны, заголовки, стили линий 

осей и многие другие параметры. Чтобы открыть окно свойств плоттера 

(Page Properties) или окно свойств активного графика, воспользуйтесь 

пунктами меню Редактировать→Свойств плоттера (Edit→Page 

Properties) или Редактировать→Свойства графика (Edit→Properties), 

рис. 4.34 и 4.35 соответственно, или нажмите на соответствующие пик-

тограммы на панели свойств. 

Для инициирования курсорных измерений кликнете по соответ-

ствующей пиктограмме на панели свойств или воспользуйтесь пункта-

ми меню Вид→Отобразить курсоры (View→Show Cursors). Курсоры 
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можно перетаскивать с помощью левой кнопки мыши. Для изменения 

настроек курсора кликнете на нем правой кнопкой мыши, откроется 

контекстное меню, рис. 4.36. 

 

 

Рис. 4.34. Окно свойств 

плоттера 
Рис. 4.35. Окно свойств графика 

Можно переместить курсор на заданное значение по оси Х/Y или к 

следующему минимуму/максимуму в любом направлении, рис. 4.37. 

 

 

Рис. 4.37. Контекстное меню курсора 
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Лабораторная работа № 4.1 

Типовые схемы включения операционных усилителей 

1.1. Снятие амплитудных характеристик для схем инвертирующе-

го включения ОУ 

Соберите схему, изображенную на рис. 4.72 и реализующую функ-

цию инвертора. Операционные усилители находятся в группе Analog 

семейство Opamp. В качестве ОУ выберете OP07AH или любой другой 

OP07. Обратите внимание, что к выводу 4 подключен источник питания 

V3 отрицательной полярности 9 В, а к выводу 7 источник питания V2 

положительной полярности 9 В. 

R1

10kΩ

R2

10kΩ

V2
9 V 

XMM1

V1
1 V 

V3
9 V 

U1

OP07AH

3

2

4

7

6

81

1

0

2

0

3

5

0

4

0

0

 

Рис. 4.72. Инверсное включение ОУ с двух полярными 9В источниками 

питания 

Изменяйте входное напряжение от -9 В до 9 В через 1 В и получите 

массив данных части амплитудной характеристики. 

Соберите схему (рис. 4.72), реализующую усилитель с коэффици-

ентом усиления -10 (какой номинал резистора R2 нужно использовать, 

если R1 = 10 кОм?). 

Получите данные по выше изложенной методике, предварительно 

скорректировав значения верхнего предела входного напряжения и его 

шаг изменения. Постройте амплитудную характеристику. Определите 

уровень входного напряжения, при котором начинается переход работы 
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с линейного режима на нелинейный режим. Зафиксируйте полученные 

данные. 

Соберите схему (рис. 4.72), реализующую схему операционного 

делителя напряжения с коэффициентом передачи -0,1 (какой номинал 

резистора R2 нужно использовать, если R1 = 10 кОм?). 

Получите данные по выше изложенной методике, предварительно 

скорректировав значения верхнего предела входного напряжения и его 

шаг изменения. Постройте амплитудную характеристику. 

Сформируйте выводы относительно поведения амплитудных ха-

рактеристик схем с различными значениями коэффициента усиления. 

 

1.2. Экспериментальное подтверждение правила 1 о том, что вхо-

ды ОУ эквипотенциальны 

Переставьте вход мультиметра в точку суммирования схемы – на 

инверсный вход ОУ. Измерьте напряжение. Сформулируйте вывод: на 

каком резисторе схемы выделяется входное напряжение, на каком вы-

деляется выходное? 

 

1.3. Определение максимального значения амплитуды выходного 

гармонического напряжения в усилителе с различными цепями питания. 

1.3.1. Усилитель с двух полярным питанием 

Соберите схему, изображенную на рис. 4.73 и реализующую уси-

литель с коэффициентом усиления -10.  

Установите амплитуду источника переменного напряжения 1 В и 

частоту 1 кГц. Изменяйте амплитуду входного напряжения (Vrms) и, 

используя осциллограф, добейтесь получения максимальной амплитуды 

выходного сигнала, когда на нем не просматривается ограничение. 

Установите и зафиксируйте значения входного и выходного напряже-

ний. При измерении выходного напряжения мультиметром не забудьте 

переключить режим измерения с постоянного тока на переменный.  
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Рис. 4.73. Инвертирующее включение ОУ с двух полярными источниками 

питания  

Измените напряжение питания ОУ V2 с 9 В до 5 В и проделайте 

два предыдущих пункта. 

Восстановите напряжение питания V2 = 9 В и измените напряже-

ние питания ОУ (V3) с 9 В до 5 В. Повторите выше изложенную мето-

дику эксперимента. Составьте общую таблицу, сформируйте выводы по 

зависимости максимальной амплитуды выходного напряжения от зна-

чений напряжений источников двух полярного питания. 

 

1.3.2. Усилитель с однополярным питанием 

Соберите схему, изображенную на рис. 4.74 и реализующую схему 

инвертора по входному сигналу, поступающему с выхода источника пе-

ременного напряжения AC_POWER. Установите частоту источника пе-

ременного напряжения 1 кГц. 

Рассчитайте коэффициент передачи напряжения смещения, посту-

пающего с выхода источника питания V3 на неинвертирующий вход ОУ 

при линейном режиме его работы. Установите на выходе источника пи-

тания V3 напряжение смещения, обеспечивающее на выходе ОУ напря-

жение, равное половине напряжения источника питания, при нулевом 

сигнале источника V1. 
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Инициируйте осциллограф, просмотрите и измерьте значение 

напряжения на выходе ОУ. Соответствует ли оно ожидаемому значе-

нию? 
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Рис. 4.74. Инвертирующее включение ОУ с однополярным питанием 

Изменяйте амплитуду входного напряжения (Vrms) и добейтесь 

получения максимальной амплитуды выходного сигнала, когда на нем 

не просматривается ограничение. Измерьте значения входного и выход-

ного напряжений. Соответствуют ли они ожидаемым значениям? 

Начните изменять напряжение смещения, используя источник пи-

тания V3. Зафиксируйте изменения постоянной составляющей выход-

ного сигнала ОУ и появление возможных ограничений гармонического 

сигнала на его выходе. Разберитесь в исследуемых процессах. 
 

1.4. Исследование АЧХ и ФЧХ инвертирующего ОУ 

1.4.1. Усилитель 

Соберите схему, изображенную на рис. 4.75 и реализующую уси-

литель с коэффициентом усиления -10.  

Получить АЧХ и ФЧХ схемы можно двумя способами: с помощью 

плоттера Боде (Bode Plotter) или с помощью частотного анализа 

(AC analysis). 

Для исследования АЧХ и ФЧХ инвертирующего ОУ с помощью 

частотного анализа следует выбрать тип анализа AC analysis из меню 

Simulate/Analyses/AC analysis, откроется окно настроек, рис. 4.76, а.  
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Рис. 4.75. Схема для исследования АЧХ и ФЧХ инвертирующего ОУ 

 

  
а) б) 

Рис. 4.76. Настройки параметров анализа AC analysis 

На вкладке Frequency Parameters (рис. 4.76, а) установите началь-

ное значение частоты 100 Hz, конечное значение частоты 1 МHz и чис-
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ло шагов за декаду изменения частоты, равное 10. Чтобы просмотреть 

АЧХ и ФЧХ инвертирующего ОУ необходимо добавить в список вы-

ходных переменных напряжение на выходе ОУ. Перейдите на вкладку 

Output (рис. 4.76, б), выберете переменную соответствующую выходно-

му напряжению ОУ – V(4) (V – напряжение, 4 – номер проводника, см. 

рис. 4.75) и нажмите на кнопку . Переменная должна появиться 

в списке выбранных для анализа (рис. 4.76, б). 

Нажмите кнопку  для запуска анализа, результаты анализа 

отображаются на плоттере, рис. 4.77. 

 

Рис. 4.77. АЧХ и ФЧХ инвертирующего ОУ 

При необходимости получения значений коэффициентов усиления 

или фазового сдвига каскада на разных частотах используйте Cursors. 

Примечание: при использовании частотного анализа 

(AC analysis) амплитуда входного сигнала задается в окне AC 

Analysis Magnitude свойств источника переменного напряжения 

AC_POWER. При частотном анализе не учитывается напряжение 

питания ОУ, таким образом в отличие от реальной схемы, при ча-

стотном анализе, ОУ всегда будет находиться в линейном режиме.  
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1.4.2. Инвертор 

Переберите схему, изображенную на рис. 4.75, чтобы она реализо-

вывала схему инвертора. Повторите выше изложенную методику экспе-

римента и получите АЧХ и ФЧХ инвертора. 

 

1.4.3.  Делитель 

Соберите схему, изображенную на рис. 4.75, чтобы она реализовы-

вала схему операционного делителя напряжения с коэффициентом пе-

редачи -0,1. Получите АЧХ и ФЧХ делителя. 

 

1.5. Исследование АЧХ и ФЧХ неинвертирующего ОУ 

Соберите схему, изображенную на рис. 4.78 и реализующую уси-

литель напряжения с коэффициентом передачи +11.  
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Рис. 4.78. Схема для исследования АЧХ и ФЧХ неинвертирующего ОУ 

С помощью AC analysis получите АЧХ и ФЧХ неинвертирующего 

ОУ, рис. 4.79. 
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Рис. 4.79.  АЧХ и ФЧХ неинвертирующего ОУ 

Переберите схему, изображенную на рис. 4.78 и реализующую уси-

литель напряжения с коэффициентом передачи +2. Получите новые 

АЧХ и ФЧХ. 

Переберите схему, изображенную на рис. 4.78 и реализующую уси-

литель напряжения с коэффициентом передачи +1,1. Получите АЧХ и 

ФЧХ данной схемы. 

 

4. Контрольные вопросы 

4.1. Как определить верхнюю границу частотного диапазона ин-

вертирующего усилителя? 

4.2. Каким образом можно измерить и уменьшить напряжение 

смещения усилителя? 

4.3. Приведите и поясните схему эксперимента для доказатель-

ства инверсии переменного сигнала усилителя с помощью осциллогра-

фа. 

4.4. Какие параметры усилителя изменятся, если уменьшить 

напряжение питания? 

4.5. Сравните выходное сопротивление на постоянном токе уси-

лителя, инвертора и делителя. 
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4.6. Как определить верхнюю границу частотного диапазона не-

инвертирующего усилителя? 

4.7. Приведите и поясните схему эксперимента для доказатель-

ства неинвертирующего свойства усилителя переменного сигнала. 

4.8. Сравните входное и выходное сопротивления неинвертиру-

ющего усилителя и повторителя. 

4.9. Приведите схему исследования и поясните алгоритм получе-

ния амплитудной характеристики схемы на ОУ. 

 

5. Требования к отчету 

Отчет должен содержать:  

 цель работы; 

 схемы проведенных экспериментов; 

 результаты измерений (таблицы, графики) и заключения по ним; 

 выводы. 
 


